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)&)BRAND FOUNDATIONBrand Story

The Journey 

from Unfamiliar 

to Unforgettable 

Begins Here 

1INGVJQTRGoU�#VNCPVC�.CDQTCVQT[�HQT�.GCTPKPI�
#A.#$��YCU�ETGCVGF�VQ�

NGXGTCIG�C�FKUVKPEVKQP�WPNKMG�VJCV�QH�CP[�QVJGT�NKDGTCN�CTVU�KPUVKVWVKQP��1WT�

WPKSWG�KPVGITCVKQP�QH�%KXKE�'PICIGOGPV��)NQDCN�'FWECVKQP��2TQHGUUKQPCN�

&GXGNQROGPV�CPF�7PFGTITCFWCVG�4GUGCTEJ�RTQITCOOKPI�YKVJKP�VJG�

EQPVGZV�QH�#VNCPVCoU�VJTKXKPI��KPVGTPCVKQPCN�DWUKPGUU�NCPFUECRG�GUVCDNKUJGU�

C�OQFGN�HQT�JCPFU�QP�NGCTPKPI�FGUKIPGF�HQT�VJG���UV�EGPVWT[��'XGT[�CURGEV�

QH�VJG�#A.#$�GPXKTQPOGPV�JCU�DGGP�VJQWIJVHWNN[�GPIKPGGTGF�VQ�RTQOQVG�

EQPXGTIGPEG�CPF�EQNNCDQTCVKQP�DGVYGGP�VJG�GZRGTKGPVKCN�FKUEKRNKPGU��

9QTMKPI�HTQO�VJG�RTGOKUG�VJCV�GHHGEVKXG�EKVK\GPUJKR�TGSWKTGU�UVWFGPVU�VQ�

DG�MPQYNGFIGCDNG��VQ�DG�CDNG�VQ�WUG�YJCV�VJG[�MPQY��VQ�JCXG�VJG�ECRCEKV[�

HQT�ETKVKECN�CPCN[UKU��CPF�VQ�DG�GSWKRRGF�HQT�NKHGNQPI�NGCTPKPI��VJG��#A.#$�

RTQOQVGU�QRRQTVWPKVKGU�YJGTG�RGTUQPCN��UQEKCN��CPF�KPVGNNGEVWCN�IQCNU��

CTG�KPVGTVYKPGF�

6Q�GZGORNKH[�1INGVJQTRGoU�XKUKQPCT[�NGCFGTUJKR�KP�GZRGTKGPVKCN�NGCTPKPI��

VJG�#A.#$�UWD�DTCPF�YCU�ETCHVGF�WUKPI�CP�KPVGPVKQPCN�RTQEGUU�VJCV�

FGOQPUVTCVGU�VJG�EQNNCDQTCVKXG�URKTKV�VJCV�YKNN�HWGN�VJG�.CDQTCVQT[���

$TCPF�FGXGNQROGPV�DGICP�YKVJ�C�UGTKGU�QH�FGUKIP�VJKPMKPI�UGUUKQPU��

VJCV�GPICIGF�#A.#$�FKTGEVQTU�CPF�UVCHH�KP�CP�GZRNQTCVKQP�QH�YJCVoU�

RQUUKDNG�HQT�VJG�.CDQTCVQT[�CPF�VJQUG�KPXQNXGF��6JTQWIJ�KPVGTCEVKXG�

FKCNQIWG�CPF�DTCKPUVQTOKPI��KFGCU�YGTG�IGPGTCVGF�VQ�GZRTGUU�VJG��

#A.#$�GZRGTKGPEG�CPF�RGTUQPCNKV[��#HVGT�HWTVJGT�EQNNCDQTCVKXG��

TGƂPGOGPV��C�UGV�QH�MG[��XCNWG�DCUGF�CVVTKDWVGU��QT�FTKXGTU��YGTG�ETGCVGF���

#�DTCPF�RTQOKUG�YCU�CNUQ�CWVJQTGF�VQ�FGUETKDG�VJG�GZRGTKGPEG�QPG�ECP�

GZRGEV�YJGP�GPICIKPI�YKVJ�VJG�#A.#$��6QIGVJGT��VJGUG�GUVCDNKUJ�VJG�

DTCPF�HQWPFCVKQP�VJCV�YKNN�KPHQTO�CNN�KPKVKCVKXGU��EQOOWPKECVKQPU��CPF��

KPVGTCEVKQPU�EQPPGEVGF�VQ�VJG�.CDQTCVQT[��

6JKU�DTCPF�HQWPFCVKQP�CNUQ�UGTXGU�CU�VJG�ETGCVKXG�URTKPIDQCTF�HQT�VJG�

#A.#$�DTCPF�KFGPVKV[�KP�KVU�PCTTCVKXG�CPF�CGUVJGVKE�HQTOU��6JG�KFGPVKV[�

YCU�EQPEGKXGF�VQ�VGNN�VJG�TKEJ��GZRGTKGPVKCN�UVQTKGU�QH�VTCPUHQTOCVKQP��

GORQYGTOGPV��CPF�FKUEQXGT[�GZRGTKGPEGF�D[�QWT�UVWFGPVU�CU�VJG[�ƂPF�

VJGKT�RNCEG�KP�VJG�YQTNF��6JG�KFGPVKV[oU�CTEJKVGEVWTG�YKNN�CNUQ�DG�EQPXG[GF�

YKVJKP�#A.#$oU�RJ[UKECN�URCEG�KP�VJG�6WTPGT�.[PEJ�%CORWU�%GPVGT�CU�YGNN�

CU�KVU�FKIKVCN�URCEG�QP�VJG�YGD��5RGEKCN�CVVGPVKQP�YCU�IKXGP�VQ�VJG�KFGPVKV[oU�

FGUKIP�VQ�CEEQOOQFCVG�HWVWTG�UECNCDKNKV[�CU�VJG�.CDQTCVQT[�GXQNXGU�

#U�C�RQUKVKQPKPI�KPKVKCVKXG�HQT�VJG�7PKXGTUKV[��VJG�#A.#$�DTCPF�YKNN�GUVCDNKUJ�

1INGVJQTRG�CU�6*'�NKDGTCN�CTVU�CPF�UEKGPEGU�WPKXGTUKV[�VJCV�DTKFIGU�VJGQT[�

CPF�RTCEVKEG��6JG�#A.#$�YKNN�ICKP�C�TGRWVCVKQP�CU�VJG�pIQ�VQq�UQWTEG�HQT�

GPVTGRTGPGWTKCN�VJKPMGTU�YKVJ�VJG�MPQYNGFIG��UMKNNU��CPF�ƂGNF�GZRGTKGPEG�VQ�

NGCF�EJCPIG�CPF�OCMG�C�FKHHGTGPEG�KP�VJG�YQTNF��

WELCOME TO THE A_LAB. OGLETHORPE’S INCUBATOR  

FOR TRANSFORMATIONAL REAL-WORLD EXPERIENCE.

Brand Story



Brand Promise

An intentional structure of 
experiential experimentation, 
the A_LAB provides the 
knowledge, resources, network, 
and support to begin mapping 
an adventure that lasts a lifetime.

Our multi-disciplinary 
collaborations yield innovative 
program possibilities and 
create opportunities for 
transformative, cross-cultural 
moments. Relevant and real-
world, the combinations are as 
unlimited as your imagination.

Through meaningful collisions 
and unexpected engagements, 
your life’s journey from unfamiliar 
to unforgettable begins here.

)&*BRAND FOUNDATIONBrand Promise and Attributes

Brand Attributes

PARTICIPANTS
 ��KPPQXCVKXG

 ��EQNNCDQTCVKXG

 ��TGNGXCPV�

 ��SWCNKV[�

 ��ETGCVKXG�

 ��VTCPUHQTOCVKQPCN

 ��KPVGPVKQPCN

 ��VCPIKDNG

 ��CFXGPVWTQWU

 ��KPURKTCVKQPCN

 ��INQDCN�

 ��GZRGTKOGPVCN

 ��ƃGZKDNG�

 ��YGNEQOKPI

 ��NKHG�EJCPIKPI

PROSPECTIVES + 

INFLUENCERS
 ��TGCN�YQTNF

 ��XCNWG�41+�

 ��WPKSWG�GZRGTKGPEG

 ��TGNGXCPEG�QH�NKDGTCN�CTVU

 ��GORQYGTGF�VJTQWIJ�� �

� GZRQUWTG

 ��KPVGITCVGF�NKHG�DWKNFKPI�� �

� RQUUKDKNKVKGU

BENEFACTORS
 ��RTKFG

 ��UWUVCKPCDNG��

� KPXGUVOGPV�

 ��DWKNFU�ECRCEKV[�

� HQT�EJCPIG

 ��KPPQXCVKQP�EJCPIKPI�� �

� GFWECVKQP�OQFGN

COMMUNITY
 ��RTKFG�HQT�#6.�EQOOWPKV[��� �

� 
�DWUKPGUUGU�

 ��ETGFKDKNKV[�TGRWVCVKQP��

 ��RQUKVKXG�KORCEV

BENEFICIARIES: COMPANIES 

+ ORGANIZATIONS
 ��YGNN�TQWPFGF�VJKPMGTU��� � �

� RTQDNGO�UQNXGTU�YKVJ�GZRGTKGPEG�

 ��GPVTGRTGPGWTKCN�VJKPMGTU

 ��GORNQ[GGU�
�XQNWPVGGTU�

� YKVJ�C�UGPUG�QH�TGURQPUKDKNKV[��

� EQOOKVOGPV�VQ�EKVK\GPT[�CPF�

� VJG�YQTNF

 GZRGTKGPEGF�YQTMHQTEG

BENEFICIARIES: FACULTY
 ��PGY�RGTURGEVKXGU�KP�

� ENCUU�FKUEWUUKQP�

 �CRRN[�%QTG�KP�TGCN�YQTNF

 �OQTG�GZRQUWTG�HQT�HCEWNV[�TGUGCTEJ

 � KPETGCUKPI�WPFGTITCFWCVG�TGUGCTEJ�

� GHHQTVU



Glass doors glide open 

with a whisper of cool air. 

A crackling, whirling 

environment is revealed 

full of movement, images, 

conversation, noise, culture, 

and information. Step into the 

glow of infinite possibility. 

Stand on the edge and 

look out, not down. 

Engage awareness, 

embrace new ideas, and 

challenge assumptions. 

Your intellect is 

suddenly thrust into the 

arms of imagination. 

Synapses fire. Dots connect. 

Synergies intensify. 

New perspectives fire to  

unite passion with purpose, 

the head with the heart. 

You’ve just crossed the 

threshold of the A_LAB.

BRAND VOICE
6JG�XQKEG�QH�VJG�#A.#$�KU�URKTKVGF��ETKUR��UWTRTKUKPI��

CPF�GXQECVKXG��+V�ECP�DG�CUUGTVKXG�CPF�EJGGM[��QT�SWKGV�CPF�

RQVGPV��+V�JCU�CP�GPGTIGVKE�RGTUQPCNKV[�VJCV�EQOOCPFU�

CVVGPVKQP��9JGP�YTKVKPI�HQT�#A.#$�EQOOWPKECVKQPU��WUG�

RJTCUGU�VJCV�EQPXG[�KOCIKPCVKQP��XKVCNKV[��RQVGPVKCN��CPF�

GOQVKQP��%JQQUG�YQTFU�VJCV�URCTMNG��UOQNFGT��CPF�UK\\NG�VQ�

GZEKVG�CNN�VJG�UGPUGU��&GUETKDG�VJG�#A.#$�YKVJ�FGVCKNU�VJCV�

VCMG�VJG�TGCFGT�KPVQ�WPGZRGEVGF�VGTTKVQT[��'PCDNG�VJGO�VQ�HGGN�

GCEJ�OQOGPV�QH�CP�GZRGTKGPEG�CPF�KVU�TGCNK\CVKQPU��6GNN�VJG�

VTCPUHQTOCVKQPCN�UVQT[�QH�GZRGTKGPVKCN�NGCTPKPI�

5QOG�EQOOWPKECVKQP�YKNN�TGSWKTG�OQTG�KPHQTOCVKQPCN�PWVU�CPF�

DQNVU��$WV�VJKU�FQGUPoV�JCXG�VQ�OGCP�FT[�CPF�DTKVVNG��*GCFNKPGU�

OWUV�UVKNN�JCXG�EJCTCEVGT��'XGP�VJG�ITCPWNCT�FGVCKNU�ECP�JCXG�

GFIGU��/CUVGT�VJG�DCNCPEG�QH�KOCIKPCVKXG�CPF�ETGFKDNG�

A_LAB IN EDITORIAL FORM
9JGP�WUGF�KP�PCTTCVKXG��#A.#$�UJQWNF�CNYC[U�DG�SWCNKƂGF�

QP�ƂTUV�TGHGTGPEG�WUKPI�VJG�HWNN�PCOG��#VNCPVC�.CDQTCVQT[�

HQT�.GCTPKPI�
#A.#$��QT�#VNCPVC�.CDQTCVQT[�HQT�.GCTPKPI��MPQYP�

CU�#A.#$�

+P�VGZV�HQTO��#A.#$�KU�CNYC[U�YTKVVGP�KP�CNN�ECRU��#P�WPFGTUEQTG�

YKVJ�PQ�URCEG�QP�GKVJGT�UKFG�UGRCTCVGU�VJG��#�CPF�.#$��6JG�

WPFGTUEQTG�U[ODQNK\GU�VJG�FKXGTUG�RQUUKDKNKVKGU�CPF�WPTGCNK\GF�

RQVGPVKCN�VJCV�CYCKV�YKVJKP�VJG�NCDQTCVQT[��6JG�PCOG�KU�PGXGT�UGV�

KP�KVCNKEU�

)&+Brand Expression BRAND FOUNDATION



Elevator Pitch

6JG�#VNCPVC�.CDQTCVQT[�HQT�.GCTPKPI�
#A.#$��DTKFIGU�ENCUUTQQO�

VJGQT[�CPF�TGCN�YQTNF�GZRGTKGPEG�VJTQWIJ�KPVGTPUJKRU��

ECTGGT�FGXGNQROGPV��UVWF[�CDTQCF��EKXKE�GPICIGOGPV��CPF�

WPFGTITCFWCVG�TGUGCTEJ��5VWFGPVU�YKNN�VCMG�YJCV�VJG[�NGCTP�KP�

VJG�ENCUUTQQO�KPVQ�#VNCPVC�CPF�DG[QPF��CPF�VJGP�DTKPI�VJQUG�

GZRGTKGPEGU�DCEM�VQ�VJG�ENCUUTQQO��FGXGNQRKPI�VJGKT�CDKNKVKGU�VQ�

U[PVJGUK\G��ETGCVG�CPF�KPXGPV�

THERE IS ONE A_LAB, WITH FOUR AREAS OF FOCUS 
���)CKP�PGY�RGTURGEVKXGU�QP�VJG�JWOCP�GZRGTKGPEG�VJTQWIJ��

� UGTXKEG�KP�VJG�#VNCPVC�EQOOWPKV[�CPF�DG[QPF��

���%JCNNGPIG�VJGKT�YQTNF�XKGY�CPF�GZRGTKGPEG�NGCTPKPI�VJTQWIJ��

� ETQUU�EWNVWTCN�OQOGPVU�YJKNG�UVWF[KPI�CTQWPF�VJG�INQDG��

���8GPVWTG�KPVQ�VJG�YQTNF�QH�YQTM�CPF�NGCTP�XCNWCDNG�NGUUQPU��

� KPVGTPKPI�HQT�UQOG�QH�VJG�OQUV�PQVGF�DTCPF�PCOGU�KP�VJG��

� YQTNF��CNN�YJKNG�DWKNFKPI�C�TGUWOG��

���%QNNCDQTCVG�CETQUU�FKUEKRNKPGU�YKVJ�UVWFGPVU�CPF�HCEWNV[�VQ��

� TGUGCTEJ��TGFGƂPG�CPF�VJKPM�QH�UQNWVKQPU�VQ�VJG�YQTNFoU��

� ITGCVGUV�RTQDNGOU��CPF�VJGP�RWV�VJGKT�VJQWIJVU�KPVQ�CEVKQP�

Key Messages

THEORY INTO PRACTICE
6JG�#A.#$�KU�CP�GZRGTKGPEG�KPEWDCVQT��+V�DTKFIGU�VJG�FKXKFG�

DGVYGGP�EQPEGRVU�CPF�VJGQT[�NGCTPGF�KP�VJG�ENCUUTQQO�CPF�

VJGKT�RTCEVKECN�CRRNKECVKQP�KP�VJG�ƂGNF��+V�FGGRGPU�VJG�NKDGTCN�

CTVU�GFWECVKQP�D[�DTKPIKPI�C�TGCN�YQTNF�EQPVGZV�VQ�VJG�ETKVKECN�

VJKPMKPI�UMKNNU�UVWFGPVU�CESWKTG�KP�VJG�%QTG�CPF�RTQXKFGU�C�

PGY�RGTURGEVKXG�QP�VJGKT�KORNKECVKQPU�CPF�XCNWG�VJTQWIJ�

GZRGTKGPVKCN�NGCTPKPI��YKVJ�VJG�IQCN�QH�KPETGCUKPI�UVWFGPVUo�

EJCPEG�VQ�UWEEGGF��

CONNECTED LABORATORY
6JG�#A.#$�UGTXGU�CU�C�NCWPEJ�RCF�HQT�PGY�ITCFWCVGU�RTGRCTKPI�

VQ�GPVGT�#VNCPVCoU�VJTKXKPI�DWUKPGUU�CPF�UGTXKEG�NCPFUECRG��

'ZRQUWTG�VQ�C�RQYGTHWN�PGVYQTM�QH�NQECNN[�DCUGF�INQDCN�

EQTRQTCVKQPU��QTICPK\CVKQPU��CPF�NGCFGTU��RNWU�EQPXGPKGPV�

CEEGUU�VQ�WPKSWG�TGNCVKQPUJKRU�YQTNFYKFG��RTQXKFGU�UVWFGPVU�

FGGR�TGUQWTEGU�HQT�UVKOWNCVKPI�GZRGTKOGPVCVKQP�

COLLABORATIVE PROBLEM-SOLVING
6JG�#A.#$�KU�CP�GPXKTQPOGPV�QH�HTGG�HQTO�VJKPMKPI�CPF�

GZRNQTCVKQP�YJGTG�CP[VJKPI�KU�RQUUKDNG��+V�RTQXKFGU�C�EQPVTQNNGF�

GPXKTQPOGPV�KP�YJKEJ�UVWFGPVU�ECP�PWTVWTG�CPF�ITQY��

GZRGTKOGPV�CPF�HCKN��+V�NKXGU�CU�C�TGUQWTEG�HQT�EQNNCDQTCVKXG�

KFGCVKQP�DGVYGGP�UVWFGPVU��HCEWNV[��UVCHH�CPF�GZVGTPCN�RCTVPGTU��

/WNVKRNG�RGTURGEVKXGU��FKXGTUG�VCNGPVU��CPF�WPDTKFNGF�ETGCVKXKV[�

HQEWUGF�QP�JWOCP�EGPVGTGF�RTQDNGOU�KPURKTG�VJG�OQUV�

KPXGPVKXG�UQNWVKQPU��

EMERGING CHANGE AGENTS
6JG�#A.#$�EWNVKXCVGU�DTKIJV�OKPFU�VJCV�CURKTG�VQ�UQNXG�VJG�

YQTNFoU�DKIIGUV�EJCNNGPIGU��5VWFGPVU�GPEQWPVGT�RTQDNGOU�

VJTQWIJ�VJGKT�RGTUQPCN�ƂGNF�GZRGTKGPEG�CPF�NGCTP�VQ�CRRN[�

MPQYNGFIG�CPF�ETGCVKXKV[�YKVJ�CP�KPVGPVKQPCN�RWTRQUG�VQYCTFU�

EJCPIG��#P�WPFGTUVCPFKPI�QH�TGURQPUKDNG��EQORCUUKQPCVG�

NGCFGTUJKR�GOGTIGU�YKVJ�C�HQEWUGF�EQOOKVOGPV�QP�OCMKPI�C�

DGVVGT��OQTG�UWUVCKPCDNG�HWVWTG�HQT�OCPMKPF�

)&,Brand Messaging BRAND FOUNDATION
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*&)LOGO STANDARDSPrimary Logo / Overview

The following configuration is the  

primary logo for A_LAB. It includes 

the A_LAB mark as well as the  

A_LAB and University descriptor  

text below.

This is the preferred logo version.

7KH�ORJRW\SH�IRU�$B/$%�PHUJHV�WKH�k/y�DQG�WKH�k$y�

OHWWHUIRUPV�LQ�k/$%y�WR�FUHDWH�D�FXVWRP�OLJDWXUH�

7KH�UDWLR�RI�WKH�GLPHQVLRQV�RI�WKH�ORJR�PXVW�DOZD\V�

EH�PDLQWDLQHG�DQG�QHYHU�DOWHUHG�

7KH�KHLJKW�RI�WKH�kBy��XQGHUVFRUH��VHUYHV�DV�D�JXLGH�

IRU�SURSHU�SODFHPHQW�RI�WKH�GHVFULSWRU�WH[W�LQ�UHODWLRQVKLS�

WR�WKH�$B/$%�PDUN�

7KLV�VSDWLDO�UHODWLRQVKLS�DSSOLHV�WR�HYHU\�ORJR�YDULDWLRQ�ZLWK�D�

GHVFULSWRU�EHORZ�WKH�PDUN��6HH�����IRU�PRUH�LQIRUPDWLRQ�

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

A_LAB mark

logo

x
2x

descriptor



*&*Logo Configurations / Primary and Secondary

The lead logo offers both horizontal 

and vertical configurations. The 

horizontal configuration is the 

preferred, primary version. The 

vertical configuration may be used 

as a secondary option when better 

suited for a layout’s application.

7KH�UXOHV�GHVFULEHG�LQ�VHFWLRQ�����DSSO\�WR�WKH�KRUL]RQWDO�

YDULDWLRQV�EHORZ��

7KH�YHUWLFDO�DOWHUQDWHV�HPSOR\�D�QHZ�VHW�RI�VSDFLQJ�UXOHV�IRU�

WKH�UHODWLRQVKLS�EHWZHHQ�WKH�$B/$%�PDUN�DQG�WKH�GHVFULSWRU��

LOGO STANDARDS

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

PRIMARY LOGO WITH MARK AND DESCRIPTOR

VERTICAL ALTERNATE LOGO WITH NO DESCRIPTORALTERNATE LOGO WITH MARK ONLY, NO DESCRIPTOR

Atlanta Laboratory for Learning

ALTERNATE LOGO WITHOUT UNIVERSITY DESCRIPTOR

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

½x

x

VERTICAL ALTERNATE LOGO WITH DESCRIPTOR



*&+Area Logos / Overview

Each area within A_LAB has a logo 

variation with its center descriptor.

7KH�VDPH�VHWXS�DQG�VSDFLQJ�UXOHV�RXWOLQHG�IRU�WKH�SULPDU\�

ORJR��VHFWLRQ������DSSO\�WR�WKH�DUHD�VSHFLoF�ORJRV��7KH�VDPH�

VSDWLDO�UHODWLRQVKLS�EHWZHHQ�WKH�PDUN�DQG�WKH�GHVFULSWRU�

PXVW�EH�XVHG�

LOGO STANDARDS

Civic Engagement
OGLETHORPE UNIVERSITY

Global Education
OGLETHORPE UNIVERSITY

Professional Development
OGLETHORPE UNIVERSITY

Undergraduate Research
OGLETHORPE UNIVERSITY

Civic Engagement
OGLETHORPE UNIVERSITY

x
2x

descriptor

A_LAB mark

logo



PRIMARY AREA LOGO WITH DESCRIPTOR

ALTERNATE AREA LOGO 
WITHOUT UNIVERSITY DESCRIPTOR

Civic Engagement
OGLETHORPE UNIVERSITY

Civic Engagement

*&,Area Logo Configuration / Primary and Alternate

Just as the primary logo, as detailed in 

section 2.2, each area logo offers both 

horizontal and vertical configurations 

that may be used in the appropriate 

applications. 

LOGO STANDARDS

Civic 
Engagement

Professional
Development

Global 
Education

Undergraduate 
Research

ALTERNATE VERTICAL AREA LOGO USING CENTER DESCRIPTOR

½x

x

Civic Engagement
OGLETHORPE UNIVERSITY

ALTERNATE VERTICAL AREA LOGO WITH DESCRIPTOR



*&-Dimensions & Sizing / Clearspace

All logo variations should be placed 

with an adequate amount of clear 

space around all sides of the logo. 

This best practice ensures that the 

logo will maintain a strong presence 

in any application.

7KH�PHWULF�IRU�GHWHUPLQLQJ�WKH�DPRXQW�RI�FOHDU�VSDFH�IRU�HDFK�

ORJR�YDULDWLRQ�LV�HTXLYDOHQW�WR�WKH�FDSLWDO�k$y�LQ�WKH�ORJR��

LOGO STANDARDS

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Civic Engagement
OGLETHORPE UNIVERSITY



*&.Dimensions & Sizing / Minimum Size

In order to maintain legibility in all 

applications, logo variations should 

always be used at the minimum size 

or larger.

LOGO STANDARDS

Minimum size:
.63” high Atlanta Laboratory for Learning

OGLETHORPE UNIVERSITY

Minimum size:
.35” highMinimum size:

.15” high

PRIMARY LOGO MINIMUM SIZE AREA LOGO MINIMUM SIZE

Minimum size:
.63” high Civic Engagement

OGLETHORPE UNIVERSITY

Minimum size:
1.2” high

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Minimum size:
.35” high

Minimum size:
.35” high Atlanta Laboratory for Learning Civic Engagement

Minimum size:
1.2” high

Civic Engagement
OGLETHORPE UNIVERSITY

Civic 
Engagement



The two colors of the primary logo 

are PMS 109 and Process Black. 

7KH�SULPDU\�PHWKRG�XVH�WKH���FRORU�YHUVLRQ�

ZKHQHYHU�SRVVLEOH�RQ�D�ZKLWH�RU�RWKHU�OLJKW�

FRORUHG�EDFNJURXQG��

,Q�DOO�PXOWLFRORU�YDULDWLRQV��WKH�kBy�

�XQGHUVFRUH��VKRXOG�DOZD\V�EH�306�����

�\HOORZ��RU�D�VXLWDEOH�DOWHUQDWH�DV�GHWDLOHG�

LQ�6HFWLRQ�����

PRIMARY LOGO: 2-COLOR

PRIMARY LOGO: 1-COLOR

*&/Color Specifications / Primary Usage LOGO STANDARDS

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

CENTER LOGOS: 3-COLOR

Civic Engagement
OGLETHORPE UNIVERSITY

Professional Development
OGLETHORPE UNIVERSITY

Global Education
OGLETHORPE UNIVERSITY

Undergraduate Research
OGLETHORPE UNIVERSITY

Civic 
Engagement

Professional
Development

Global 
Education

Undergraduate
Research

The 3-color, center-specific versions 

use the primary brand colors for the 

“_” (underscore) and descriptor text 

found in the lead logo. The letters 

for “A” and “LAB” use a center-

specific color from the extended brand 

palette. These colors are to be used 

consistently in all applications.

&HQWHU�VSHFLoF�FRORU�SDLULQJV�

&LYLF�(QJDJHPHQW��306����

*OREDO�(GXFDWLRQ��306�����

3URIHVVLRQDO�'HYHORSPHQW��306�2UDQJH����

5HVHDUFK�	�6FKRODUVKLS��306�3URFHVV�&\DQ

7KHVH�FHQWHU�VSHFLoF�FRORU�SDLULQJV�VKRXOG�

EH�XVHG�LQ�DOO�DSSURSULDWH�DSSOLFDWLRQV��

3OHDVH�VHH�6HFWLRQ�����IRU�PRUH�LQIRUPDWLRQ�



:KHQ�UHYHUVLQJ�WKH�ORJR�RXW�RI�D�

FRORU�EDFNJURXQG��EH�VXUH�WKH�ORJR�

LV�ODUJH�HQRXJK�IRU�WKH�GHVFULSWRU�

WH[W�WR�EH�UHDGDEOH�ZLWK�VXIoFLHQW�

FRQWUDVW�

The logo may only be reversed 

out of the following primary 

brand colors:

Process Black

PMS 254

PMS Orange 021

PMS 3268

Process Cyan

The “_” (underscore) MUST 

remain yellow in all reversals. 

Therefore all primary brand 

colors are permitted for 

reversal of the logo except 

Yellow (PMS 109). 

The logo may used as a 1-color 

black version, including the “_” 

(underscore). 

This 1-color black version of 

the logo allows for use on the 

primary yellow background 

color (PMS 109) and for use on 

naturally based materials like 

raw paperboard. 

*&0Color Specifications / Reversals & 1-Color LOGO STANDARDS

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY



The logo may be used on top of 

photography or reversed out of the 

photograph when necessary. 

The placement of the logo must 

maintain readability of the yellow 

“_” (underscore).

,I�WKH�ORJR�LV�SODFHG�RQ�WRS�RU�UHYHUVHG�RXW�RI�D�SKRWRJUDSK��

WKH�DUHD�VXUURXQGLQJ�WKH�ORJR�PXVW�KDYH�YHU\�OLWWOH�SDWWHUQ�RU�

WH[WXUH��7KH�ORJR�VKRXOG�EH�RI�VXEVWDQWLDO�VL]H�DQG�WKH�EDFN�

JURXQG�VKRXOG�SURYLGH�HQRXJK�FRQWUDVW�IRU�FOHDU�UHDGDELOLW\�

*&1Color Specifications / With Photography LOGO STANDARDS

REVERSED LOGO ON A PHOTO

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

PRIMARY LOGO ON A PHOTO

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY



Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Whether the logo prints in one 

or two colors or reversed in white, 

it must appear against a background 

of sufficient contrast for clear read-

ability.  Be sure to follow the color 

guidelines for logo specification 

and application.

'R�QRW�XVH�XQDFFHSWDEOH�FRORUV�IRU�WKH�HQWLUH�

ORJR�RU�IRU�SDUWV�RI�WKH�ORJR��7KLV�LQFOXGHV�

XQDFFHSWDEOH�EUDQG�FRORUV��'R�QRW�DGG�DQ\�

HIIHFWV�WR�WKH�ORJR�VXFK�DV�EHYHOV�RU�GURS�

VKDGRZV��7KH�ORJR�VKRXOG�QHYHU�EH�DQLPDWHG��

IROGHG��GLPHQVLRQDOL]HG�RU�VWUHWFKHG�

'R�QRW�DWWHPSW�WR�UHFUHDWH�WKH�ORJR�\RXUVHOI��

FKDQJH�WKH�IRQW�RU�DOWHU�WKH�VL]H�RU�SURSRUWLRQV�

'R�QRW�HQFORVH�WKH�ORJR�LQ�D�VKDSH��URWDWH�LW��

LQYHUW�LW��VSLQ�LW�RU�SLYRW�LW�

'R�QRW�XVH�WKH�ORJR�DV�SDUW�RI�DQRWKHU�ORJR�

RU�V\PERO��

'R�QRW�XVH�WKH�ORJR�LQ�D�KHDGOLQH�RU�VHQWHQFH�

'R�QRW�SODFH�WKH�ORJR�RQ�SKRWRJUDSK\�RU�YHFWRU�

DUW�ZLWK�EXV\�EDFNJURXQGV��'R�QRW�UHYHUVH�

WKH�ORJR�RXW�RI�D�OLJKW�FRORUHG�EDFNJURXQG��

'R�QRW�SXW�D�FRORU�RU�EODFN�ORJR�RQ�D�GDUN�

SKRWRJUDSKLF�RU�YHFWRU�EDFNJURXQG��XQOHVV�

WKHUH�LV�VXIoFLHQW�FRQWUDVW�

'R�QRW�UHYHUVH�WKH�ORJR�RXW�RI�XQDFFHSWDEOH�

FRORUV��'R�QRW�UHYHUVH�RQO\�SDUW�RI�WKH�ORJR�

IURP�D�FRORU�

'R�QRW�UHYHUVH�WKH�ORJR�RXW�RI�D�OLJKW�

EDFNJURXQG��'R�QRW�XVH�D�FRORU�RU�EODFN�

ORJR�RQ�D�GDUN�EDFNJURXQG�

*&)(Color Specifications / Unacceptable Usage LOGO STANDARDS

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY



Color Palette    +&)
Typography    +&+

Graphic Elements   �+&,
Photography    +&)(

VISUAL IDENTITY ELEMENTS +



GOLD
PMS 109 C
CP: 0/10/100/0 
PMS 109 U
UP: 0/14/96/0 
HEX# FFDD00
RGB: 255/215/0

PURPLE
PMS 254 C
CP: 52/96/0/0 
PMS 254 U
UP: 37/74/0/0 
HEX# 952D98
RGB: 149/45/152

MAGENTA
PROCESS 
MAGENTA C
CP: 0/100/0/0 
PROCESS 
MAGENTA U
UP: 0/100/0/0 
HEX# D10074
RGB: 209/0/116

ORANGE
PMS OR 021 C
CP: 0/68/100/0 
PMS OR 021 U
UP: 0/45/86/0 
HEX# FF5800
RGB: 255/88/0

DARK ORANGE
PMS 1805 C
CP: 5/96/76/21 
PMS 1805 U
UP: 7/78/68/13 
HEX# AA272F
RGB: 170/39/47

GREEN
PMS 3268 C
CP: 89/0/50/0 
PMS 3268 U
UP: 66/0/42/0 
HEX# 00B092
RGB: 0/176/146

LIGHT GREEN
PMS 381 C
CP: 23/0/89/0 
PMS 381 U
UP: 25/0/84/0 
HEX# C9DD03
RGB: 201/221/3

CYAN
PROCESS CYAN C
CP: 100/0/0/0 
PROCESS CYAN U
UP: 100/0/0/0 
HEX# 009FDA
RGB: 0/159/218

DARK BLUE
REFLEX BLUE C
CP: 100/82/0/2 
REFLEX BLUE U
UP: 92/70/0/0 
HEX# 002395
RGB: 0/35/149

7KHVH�FRORU�IRUPXODV�VKRXOG�EH�XVHG�IRU�WKHLU�VSHFLoF�

DSSOLFDWLRQV�q�SULQW��ZHE�DQG�VSRW�FRORUV��6SRW�FRORUV�

VKRXOG�EH�XVHG�ZKHQHYHU�SRVVLEOH�IRU�WKH�WUXHVW�FRORU�

The A_LAB color palette is similar 

to Oglethorpe’s main palette, 

and adopts the school’s primary 

colors. A secondary color palette 

is introduced to offer extended 

combinations and contrasts.

+&)VISUAL IDENTITY ELEMENTSColor Palette / Primary & Secondary

BLACK
PROCESS BLACK C
CP: 0/0/0/100 
PROCESS BLACK U
UP: 0/0/0/100 
HEX# 1E1E1E
RGB: 30/30/30

PRIMARY CENTER COLORS

PRIMARY BRAND COLORS

SECONDARY/ACCENT CENTER COLORS



Futura Light
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz 

Futura Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

0LOOHU�5RPDQ
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

>mlmjY�;gf\]fk]\�E]\ame
9:;<=>?@ABCDEFGHIJKLMNOPQR
YZ[\]^_`abcdefghijklmnopqr 

/FǶǹPO�5FǳVǷBǸ
$%ǫ'()*+,Ǭǭ/0123Ǯ5678ǯ:;<ǰ
BCǱEFǲǳIǴǵǶǷNOPQRǸTǹVǺXYǻ[

Serifa Light
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz 

Serifa Roman
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

Serifa Bold
ABCDEFGHIJKLMNOPQRSTUVWXYZ
abcdefghijklmnopqrstuvwxyz

The A_LAB brand typefaces 

should be used for all applications. 

HTML alternates are provided 

in Section 3.3.

2YHUDOO��YDULDWLRQ�LQ�WKH�ZHLJKW�DQG�VW\OH�RI�

W\SH�ZLOO�FUHDWH�DQ�LQWHUHVWLQJ�OD\RXW��%RWK�

6HULID�DQG�)XWXUD�PXVW�EH�SUHVHQW�LQ�HYHU\�

OD\RXW��EXW�FDQ�EH�XVHG�LQ�GLIIHUHQW�ZD\V�

HEADLINES

6HULID�VKRXOG�EH�XVHG�IRU�OHDG�PHVVDJLQJ�

WR�EDODQFH�WKH�KHIW�RI�WKH�)XWXUD�EDVHG�

$B/$%�ORJR��:KHQ�SDLULQJ�DQ�DWWULEXWH�

ZRUG��VHH�6HFWLRQ������ZLWK�WKH�$B/$%�ORJR��

LW�VKRXOG�DOZD\V�EH�VHW�LQ�6HULID��

6XE�KHDGOLQHV�IROORZLQJ�D�6HULID�KHDGOLQH�

VKRXOG�XVH�)XWXUD�

BODY COPY AND CAPTIONS

%RG\�FRS\�VKRXOG�EH�VHW�LQ�6HULID��

)RU�FRQWUDVW��VXEKHDGV�ZLWKLQ�ERG\�WH[W�

DUH�VHW�LQ�)XWXUD��0LOOHU�5RPDQ�PD\�DOVR�EH�

XVHG�IRU�ERG\�WH[W�DV�D�VXEVWLWXWH�IRU�6HULID�

&DSWLRQV�DQG�LQIRUPDWLRQDO�FRS\�LV�VHW�

LQ�/HNWRQ�

DISPLAY TYPE

6HULID�DQG�)XWXUD�FDQ�EH�XVHG�IRU�

GLVSOD\�SXUSRVHV�

$B/$%
V�EUDQG�W\SHIDFHV�q�6HULID��)XWXUD��

0LOOHU��/HNWRQ�q�GR�QRW�FRPH�DV�VWDQGDUG�

W\SHIDFHV�RQ�D�3&�RU�0DF��$�XVDJH�OLFHQVH�

PXVW�EH�SXUFKDVHG�WR�GRZQORDG�WKH�VRIWZDUH�

IRU�LQVWDOODWLRQ�DQG�XVH��3OHDVH�FRQWDFW�

8QLYHUVLW\�&RPPXQLFDWLRQV�WR�GHWHUPLQH��

KRZ�WR�REWDLQ�WKH�EUDQG�W\SHIDFHV�IRU�XVH�

+&*VISUAL IDENTITY ELEMENTSTypography / Primary



*HRUJLD�5HJXODU
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

*HRUJLD�%ROG
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

*HRUJLD�,WDOLF
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

Two typefaces are provided as 

alternates for A_LAB’s brand 

typefaces. Georgia is a serif 

substitute for Serifa. Arial is a 

sans serif substitute for Futura. 

7KHVH�W\SHIDFHV�VKRXOG�RQO\�EH�XVHG

IRU�GLJLWDO�DSSOLFDWLRQV�UHTXLULQJ�+70/�

IRQWV�ZKHQ�WKH�W\SHNLW�ZHE�IRQWV�FDQQRW�

EH�XVHG��

)RU�DUHDV�RI�D�GLJLWDO�FRPPXQLFDWLRQ�

ZKHUH�W\SRJUDSK\�PLJKW�EH�XVHG�DV�D�

JUDSKLF�HOHPHQW��VXFK�DV�D�KHDGOLQH��

FDOO�RXW�TXRWH��GURS�FDSLWDO���WKH�RIoFLDO�

$B/$%�EUDQG�W\SHIDFHV�DUH�UHFRPPHQGHG�

IRU�FRQVLVWHQF\��,W�LV�LPSRUWDQW�WR�

UHPHPEHU�WKDW�ZKHQ�XVHG�WKLV�ZD\��WKH�

W\SH�PXVW�EH�FRQYHUWHG�LQWR�D�pDW�LPDJH�

VXFK�DV�D��MSJ���SQJ�RU��JLI��

7KLV�WUHDWPHQW�LV�QRW�UHFRPPHQGHG�IRU�

ERG\�FRS\�RU�RWKHU�XVHV�ZKHUH�FRQWHQW�LV�

FULWLFDO�IRU�VHDUFK�HQJLQH�VFDQQLQJ�

,Q�DOO�RWKHU�DSSOLFDWLRQV��HYHU\�HIIRUW�

VKRXOG�EH�PDGH�WR�XVH�$B/$%�EUDQG�

W\SHIDFHV�EHIRUH�DOWHUQDWHV�DUH�FRQVLGHUHG�

$ULDO
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

$ULDO�%ROG
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

$ULDO�,WDOLF
$%&'()*+,-./0123456789:;<=
DEFGHIJKLMNOPQRSTUVWXYZ[\]

+&+VISUAL IDENTITY ELEMENTSTypography / HTML Alternates



USING THE GRAPHIC VERTICALLY

7XUQLQJ�WKH�$B/$%�PDUN�RQ�LWV�VLGH��ULJKW�

UHDGLQJ�GRZQ��DOORZV�WKH�kBy��XQGHUVFRUH��

WR�EH�oOOHG�ZLWK�RQH�RU�D�VHULHV�RI�DWWULEXWH�

ZRUGV�RU�SKUDVHV��VHH�6HFWLRQ�����IRU�PRUH�

LQIRUPDWLRQ���6L]H�DQG�SODFHPHQW�RI�WKH�ZRUGV�

RU�SKUDVH��UHODWLYH�WR�WKH�$B/$%�PDUN��PXVW�

DOORZ�DGHTXDWH�FOHDU�VSDFH��

7KH�VSDFH�SURYLGHG�E\�WKH�kBy��XQGHUVFRUH��

PD\�DOVR�EH�oOOHG�ZLWK�KDQGZULWWHQ�HOHPHQWV��

DV�XVHG�RQ�QDPH�WDJ�DSSOLFDWLRQV��VHH�6HFWLRQ�

�����IRU�H[DPSOHV��

The bold, graphic nature of the 

A_LAB mark can be used to 

emphasize the dynamic, open-ended 

experience that makes A_LAB 

unique. The underscore provides a 

space for message customization 

and emphasis.

+&,VISUAL IDENTITY ELEMENTSGraphic Elements / A_LAB Graphic

learning

bigger ideas change-making
building knowledge



$Q�DWWULEXWH�ZRUG�RU�SKUDVH�FDQ�EH�FRPELQHG�ZLWK�WKH�

$B/$%�ORJR��VHH�6HFWLRQ�������7KH�FKRVHQ�ZRUG�V��PXVW�

EH�JUDPPDWLFDOO\�FRUUHFW�ZKHQ�IROORZLQJ�WKH��k$�y�$YRLG�

ZRUGV�EHJLQQLQJ�ZLWK�D�YRZHO�WKDW�UHTXLUH�kDQy�IRU�

JUDPPDWLFDO�DFFXUDF\�

$Q�DWWULEXWH�ZRUG�RU�SKUDVH�FDQ�EH�XVHG�ZLWKLQ�D�OD\RXW�WR�

HPSKDVL]H�D�WKRXJKW�RU�LGHD��,Q�WKLV�FDVH���WKH�YHUWLFDO��kBy�

�XQGHUVFRUH��LV�XVHG�DORQH�DV�D�FRORU�EDU�DQG�VHUYHV�DV�D�

JUDSKLF�DQFKRU��VHH�H[DPSOH�LQ�6HFWLRQ������

$�VHULHV�RI�DWWULEXWH�ZRUGV�SKUDVHV�FDQ�DOVR�EH�FRPELQHG�WR�

FUHDWH�G\QDPLF�PHVVDJLQJ��:KHQ�XVHG�LQ�WKLV�ZD\��WKH�ZRUGV�

VKRXOG�EH�GLIIHUHQWLDWHG�XVLQJ�VSDFLQJ�DQG�RU�EUDQG�FRORUV�

A_LAB’s defining attributes are 

always expanding. These attribute 

words can be used for emphasis and 

variety in the A_LAB’s messaging.

+&-VISUAL IDENTITY ELEMENTSGraphic Elements / Attribute Words

Real World Doing Things Differently 
Unique Transformational Flexible
Timely Global Creative Diving In
Relevant Sustainable Eye-Opening
5($/�:25/'�'2,1*�7+,1*6�',))(5(17/<�81,Ǯ8(�75$16)250$7,21$/�)/(;,%/(
7,0(/<�*/2%$/�ǫ5($7,ǯ(�',ǯ,1*�,1�5(/(ǯ$17�6867$,1$%/(�(<(�23(1,1*

THE A_LAB LOGO USED WITH A SINGLE WORD/PHRASE USED WITH A VERTICAL BAR ANCHOR

IN A SERIES WITH DIFFERENTIATION

learning doing things differently

gratitude



7KH�JUDSKLF�HOHPHQWV�LQVSLUHG�E\�WUDQVLW�URXWH�PDSV�DUH�

XVHG�DV�HPSKDVLV�SRLQWV�ZLWKLQ�D�OD\RXW�OLQNLQJ�LQIRUPDWLRQ��

LQGLYLGXDO�DQG�LQWHUVHFWLQJ�QDUUDWLYHV�

7KHVH�HOHPHQWV�VKRXOG�EH�FOHDQO\�UHQGHUHG�DQG�XQLIRUP�

WR�UHSUHVHQW�$B/$%
V�WHFKQRORJLFDO��SURJUHVVLYH�DQG�

FRQWHPSRUDU\�DWWULEXWHV��

7KHVH�HOHPHQWV�DUH�EHVW�UHSUHVHQWHG�XVLQJ�PXOWLSOH�

EUDQG�FRORUV��%ODFN�RU�ZKLWH�UHYHUVDO�DUH�DOVR�DFFHSWDEOH�

FRORUV�ZKHQ�FRPSRVLWLRQDOO\�DSSURSULDWH��

The A_LAB experience is a cultural, 

academic and professional journey. 

Related iconic imagery translates 

into graphic elements that evoke the 

ideas of transit routes, progression 

and convergence.

+&.VISUAL IDENTITY ELEMENTSGraphic Elements / Transit Lines

HOW TO CREATE THIS ELEMENT

1.  Each line should be drawn at 90°, 180°,  
or 45°. This can be achieved by holding  
the shift key and using the line tool in  
Adobe InDesign or Illustrator.

2.  Slightly round the angles. In InDesign, select 
the line and go to Object > Corner options. 
Set  the effect to Rounded. The example 
above is set to round the corners at .14 in. 
This number should be adjusted up or  
down depending on the size of the  
graphic element.

3.  Lines should connect at a central point.  
The ends of each line should be capped 
with outlined circles, modeled after stations 
or stops on transit maps. This can be 
achieved by selecting the line, going to 
Window > Stroke and selecting Circle under 
Type in the palette. The line weight for the 
strokes should be consistent (around 1–3pt in 
standard print or web pieces).



7KHVH�REMHFWV�DUH�SURFHVVHG�IURP�LPDJH�VRXUFHV�WKDW�FDQ�EH�

PDGH�PRQRFKURPDWLF��7KH\�VKRXOG�DOZD\V�EH�UHQGHUHG�LQ�D�

EUDQG�FRORU�WKDW�DOORZV�WKH�REMHFW�WR�VWDQG�RXW�JUDSKLFDOO\��

7KH�REMHFWV�PD\�DOVR�EH�UHYHUVHG�RXW�RI�D�EUDQG�FRORU�RU�

VLPSO\�SODFHG�RQ�D�EODFN�EDFNJURXQG�IRU�JUDSKLF�FRQWUDVW�

Image-based objects are additional 

graphic tools for illustrating 

narratives and telling brand stories.

+&/VISUAL IDENTITY ELEMENTSGraphic Elements / Storytelling Objects

HOW TO CREATE THIS ELEMENT

1.  Start with an image of a single object,  
ideally on a white background. Stock sites 
such as iStock and Veer are great resources 
for images like the examples above.

2.  Open the image in Photoshop. Convert 
the image to grayscale (Image > Mode > 
Grayscale).

3.  Increase the contrast in the image. (Image > 
Adjustments > Brightness & Contrast).

4.  Convert the image to bitmap.  
(Image > Mode > Bitmap).

5.  In the bitmap settings, set the resolution 
to 600 pixels/inch or higher. Set the 
method to 50% threshold. At this point, 
the icon will be solid black on white.

6. Save as TIFF.
7.  Place the image inside the InDesign layout. 

Change the color of the object by using  
the direct selection tool (white arrow  
in the tool palette).



7KH�GRW�PDWUL[�SDWWHUQV�VKRZQ�KHUH�DUH�H[DPSOHV�RI�LPDJHV�

WKDW�DUH�ERWK�UHFRJQL]DEOH�DQG�VXEVWDQWLDO�HQRXJK�WR�FRQYHUW�

WR�GRW�SDWWHUQV��$Q\�SLFWRULDO�VRXUFH�FDQ�EH�XVHG�DV�ORQJ�DV�LW�

PHHWV�WKLV�FULWHULD��'HOLFDWH�RU�LQWULFDWH�VRXUFHV�PD\�UHVXOW�LQ�

D�GRW�SDWWHUQ�WRR�GLIoFXOW�WR�UHFRJQL]H�

%UDQG�FRORUV�VKRXOG�DOZD\V�EH�XVHG�IRU�WKHVH�SDWWHUQV��7KH\�

PD\�DOVR�EH�UHYHUVHG�RXW�RI�D�oHOG�RI�FRORU�RU�DV�SDUW�RI�D�

OD\HUHG�FRPSRVLWLRQ��VHH�6HFWLRQ�����IRU�PRUH�LQIRUPDWLRQ���

A_LAB and its outreach exist within 

a digital world of evolving and 

constantly updated information. 

This technology sphere presents 

an opportunity for textural visual 

reference. Evoking LED news tickers 

and information boards, dot matrix 

patterns become another graphic 

tool representational of A_LAB’s 

technological sophistication.

+&0VISUAL IDENTITY ELEMENTSGraphic Elements / Dot Pattern

HOW TO CREATE THIS ELEMENT

In Photoshop
1. Convert the image to grayscale.
2. Go to Image > Mode > Bitmap
3.  Set the resolution at 300 or 

higher, and select Halftone 
Screen in the drop down menu.

4.  Adjust the lines/inch setting.  
30 lines/inch is a good mark to 
begin with, but this number will 
depend on the type of photo. 
The goal is to have a loose/
light image with plenty of space 
between the dots.

5.  Set the angle to 0 and the 
shape to round.

In Illustrator
The brand toolkit includes a file called A_LAB_Dot-Texture_Swatch.ai.  
The file includes a swatch that fills any vector shape with the dot pattern, 
functioning in the same way as a color swatch. The color of the dots in 
the artwork can be changed by converting the color fill to outlines  
(Object > Expand > Fill, then Pathfinder > Merge).



,PDJHV�XVHG�LQ�OD\HULQJ�VKRXOG�EH�JUDSKLF�DQG�VLPSOH�HQRXJK�

WR�EH�UHFRJQL]DEOH�ZLWKLQ�WKHLU�FRQWH[W��

&RORU�OD\HUV�DSSOLHG�WR�LPDJHV�PXVW�FRPH�IURP�WKH�EUDQG�

FRORU�SDOHWWH�DQG�DOORZ�OD\HUHG�PHVVDJLQJ�WR�EH�FOHDUO\�OHJLEOH��

7KH�ERUGHUV�RI�HDFK�OD\HU�VKRXOG�EH�LQWHQWLRQDO�WR�WKHLU�

FRQWH[W��7DNH�FDUH�QRW�WR�FURS�LPDJHV�KDSKD]DUGO\��

&UHDWH�YLVXDO�EDODQFH�LQ�WKH�VL]H�RI�HDFK�OD\HUHG�HOHPHQW�

Layers of texture, typography, 

graphic imagery and color 

transparencies provide an easily 

customized palette for building 

compositions and layouts. 

+&1VISUAL IDENTITY ELEMENTSGraphic Elements / Layering

121800<�1,%+�($8,602'�7,1&,'
817�87�/$25((7�'2/25(�0$*1$�



3KRWRV�VKRXOG�FDSWXUH�VLJQDWXUH�PRPHQWV�WKDW�WHOO�VWRULHV�DQG�

UHSUHVHQW�$B/$%
V�GLYHUVH�DQG�G\QDPLF�DFWLYLWLHV�RQ�FDPSXV��LQ�

$WODQWD�DQG�DURXQG�WKH�ZRUOG��7KH�EHVW�OLJKWLQJ�LV�QDWXUDO�OLJKW��

8VH�pDVK�RQO\�LI�DEVROXWHO\�QHFHVVDU\�WR�FDSWXUH�WKH�VXEMHFW�

General photography should capture 

spontaneous moments of the A_LAB 

in action. Subject matter should look 

natural. Avoid posed compositions. 

PROFESSIONAL DEVELOPMENT

GLOBAL EDUCATION

CIVIC ENGAGEMENT

RESEARCH & SCHOLARSHIP

+&)(VISUAL IDENTITY ELEMENTSPhotography / General



7KHVH�SKRWRV�VKRXOG�EH�SURIHVVLRQDO�TXDOLW\��VKRW�ZLWK�D�JUDSKLF�

DHVWKHWLF�DQG�LQWHUHVW��,PDJHV�WKDW�VXJJHVW�FROODERUDWLRQ��

FRPPXQLW\�RXWUHDFK�DQG�LQYROYHPHQW�ZLOO�EH�SHRSOH�IRFXVHG��

8VLQJ�QDWXUDO�OLJKW�LV�EHVW��

7H[WXUDO�LPDJHV�WKDW�VXJJHVW�PRYHPHQW��SURJUHVVLRQ�DQG�

FRQYHUJHQFH�FDQ�EH�VKRW�DV�D�GLPHQVLRQDO�VWLOO�OLIH�RU�EH�GHWDLOHG�

SKRWRJUDSKV�RI�DFWXDO�VXUIDFHV��IDEULF�RU�LQGXVWULDO�PDWHULDO��

In addition to the general A_LAB 

photography, concept photos 

may also be used to express the 

attributes of A_LAB and its centers. 

+&))VISUAL IDENTITY ELEMENTSPhotography / Concept and Texture

COLLABORATION

COMMUNITY & INVOLVEMENT

REPRESENTATIVE TEXTURE



3KRWRV�VKRXOG�FDSWXUH�DQ�LQGLYLGXDO
V�PRPHQW�RU�WKRXJKW�DV�LW�LV�

DFWXDOO\�XQIROGLQJ��7KHUHIRUH��LPDJHV�DUH�H[SHFWHG�WR�EH�VSRQWD�

QHRXV�DQG�ORRVH�LQ�WKHLU�H[HFXWLRQ��7KLV�SURYLGHV�D�SHUVRQDOL]D�

WLRQ�WKDW�UHVRQDWHV�DV�GLVWLQFWLYHO\�DXWKHQWLF�WR�WKH�$B/$%�VSLULW��

,PDJHV�FDSWXUHG�ZLWK�PRELOH�GHYLFH�ZLOO�XVXDOO\�EH�RI�ORZ�UHVROX�

WLRQ�DQG�WKHUHIRUH�VKRXOG�RQO\�EH�XVHG�LQ�SULQWHG�PDWHULDOV�ZLWK�

FDUHIXO�FRQVLGHUDWLRQ�RI�VL]H�YHUVXV�UHVROXWLRQ��

Telling individual stories through 

A_LAB photography is another key 

component to the brand story. Use 

of instant social media formats like 

Instagram puts photo and video 

asset creation in the hands of those 

who experience the A_LAB on a 

daily basis. 

+&)*VISUAL IDENTITY ELEMENTSPhotography / Storytelling



Print    ,&)
Advertising    ,&1

Environment   �,&)(
Specifications    ,&).

APPLICATION & IMPLEMENTATION ,

Metropolitan Current Issues Global Service 
Business Experience Innovation Engagement 
Diversity Ideation Creativity Imagination 



Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

Real World Doing Things Differently 
Unique Transformational Flexible
Timely Global Creative Diving In
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This layout shows how select  

graphic elements can be used  

for a brochure cover.

FEATURES OF THE LAYOUT TO NOTE:

���'RW�SDWWHUQ�$B/$%�PDUN

���&RQWLQXRXV�VWULQJ�RI�DWWULEXWH�ZRUGV�ZLWK�FRORU�GLIIHUHQWLDWLRQ

���3ULPDU\�$B/$%�ORJR�LQ�UHYHUVH�

,&)APPLICATION & IMPLEMENTATIONPrint / Brochure Cover

RECRUITMENT BROCHURE



This layout shows how select  

graphic elements can be used  

for a brochure interior.

FEATURES OF THE LAYOUT TO NOTE:

���'RW�SDWWHUQ�JUDSKLF

���,FRQLF�WUDQVLW�PDS�JUDSKLF�WR�GHYHORS�QDUUDWLYH

���6WRU\WHOOLQJ�REMHFWV�LQ�EUDQG�FRORUV

���7UDQVLW�LQVSLUHG�IROLR�V\VWHP

,&*APPLICATION & IMPLEMENTATIONPrint / Brochure Interior
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EBIS SIM EX ES DOMINI
'BF�TBFQFǸVN�ǸFǸP�ǹFǹ�ǺPǷPǸ�
TVOǹ�ǸFIFOǴNPTTVN�ǸFǸB�TǴ�VOǹ��
(CǴT�TǴN�FY�FT�FTTǴ�BVǹ�FǷǴǹ�
ǴQǴFǹ�ǴOǴTRVP�TTǴNǴOǹǴT�ǱPOFǹ�
FVN�ǲVǳǴǹBǹ�ǸF�ǴO�ǱVTBO��6FE�
RVF�TVN�BOEBOEǴ�ǴVǸ��VǷǷBC�ǴO�
QPǸ�TFRVǴT�

EBIS SIM EX ES DOMINI
'BF�TBFQFǸVN�ǸFǸP�ǹFǹ�ǺPǷPǸ�TVOǹ�ǸFIFOǴNPT�

TVN�ǸFǸB�TǴ�VOǹ��(CǴT�TǴN�FY�FT�FTTǴ�BVǹ�FǷǴǹ�
ǴQǴFǹ�ǴOǴTRVP�TTǴNǴOǹǴT�ǱPOFǹ�FVN�ǲVǳǴǹBǹ�ǸF�
ǴO�ǱVTBO�^6FE�RVF�TVN�BOEBOEǴ�ǴVǸ��VǷǷBC�ǴO�

QPǸ�TFRVǴT�

EBIS SIM EX ES DOMINI
'BF�TBFQFǸVN�ǸFǸP�ǹFǹ�ǺPǷPǸ�
TVOǹ�ǸFIFOǴNPTTVN�ǸFǸB�TǴ�VOǹ��
(CǴT�TǴN�FY�FT�FTTǴ�BVǹ�FǷǴǹ�
ǴQǴFǹ�ǴOǴTRVP�TTǴNǴOǹǴT�ǱPOFǹ�
FVN�ǲVǳǴǹBǹ�ǸF�ǴO�ǱVTBO�^6FE�
RVF�TVN�BOEBOEǴ�ǴVǸ��VǷǷBC�ǴO�
QPǸ�TFRVǴT�

EBIS SIM EX ES DOMINI
'BF�TBFQFǸVN�ǸFǸP�ǹFǹ�ǺPǷPǸ�
TVOǹ�ǸFIFOǴNPTTVN�ǸFǸB�TǴ�VOǹ��
(CǴT�TǴN�FY�FT�FTTǴ�BVǹ�FǷǴǹ�
ǴQǴFǹ�ǴOǴTRVP�

EBIS SIM EX  
ES DOMINI
'BF�TBFQFǸVN�ǸFǸP�ǹFǹ�
ǺPǷPǸ�TVOǹ�ǸFIFOǴNPT�
TVN�ǸFǸB�TǴ�VOǹ��(CǴT�
TǴN�FY�FT�FTTǴ�BVǹ�
FǷǴǹ�ǴQǴFǹ�ǴOǴTRVP�

Dae saeperum 
rero tet volor sunt 
rehenimossum 
rera si unt. Ebis 
sim ex es essi aut 
elit ipiet inisquo

Evellaceped 
magnihi llanimin 
prerfer chillutem 
si auta iuscidunt 
quam ipsam, vero 
officium ventotati 
ut as diti dipsum 
repratur.

Int eum 
dolupientios 
comnimi litiis 
minimod ipsandu 
ndisti tem 
facillique quia 
alique volupiet.

Em arum de 
plantia esciene 
deliature nistior 
iorerum expero 
mod mi, imus 
autem ut dolori 
demporrunt odi 
autatur, vitatiis.

Jump off. Dive in. Start here.
A-Lab integrates opportunities that  
allow you to navigate your journey.

:IP�:F�$ǸF

6ǹPǸǴFT

ǫǴǺǴǱ�(OǳBǳFNFOǹ

*ǷPCBǷ�(EVǱBǹǴPO

3ǸPǲFTTǴPOBǷ�*ǸPXǹI

6FF�QIPǹPT�BOE�ǸFBE�NPǸF��
$�/BC�QǸPǲǴǷFT�Bǹ��
B�ǷBC�PǳǷFǹIPǸQF�FEV�TǹPǸǴFT

RECRUITMENT BROCHURE

1

2

3

4



This layout shows how select  

graphic elements can be used  

for a brochure interior.

FEATURES OF THE LAYOUT TO NOTE:

���9HUWLFDO�$B/$%�PDUN�ZLWK�DWWULEXWH�ZRUG

���6WRU\WHOOLQJ�SKRWRV

���7UDQVLW�LFRQ�IROLR

���-RXUQDOLVWLF��QDUUDWLYH�WH[W�EOHHGV�RII�SDJH

���6WRU\WHOOLQJ�REMHFW

,&+APPLICATION & IMPLEMENTATIONPrint / Brochure Interior

:IP�:F�$ǸF

6ǹPǸǴFT

ǫǴǺǴǱ�(OǳBǳFNFOǹ

*ǷPCBǷ�(EVǱBǹǴPO

3ǸPǲFTTǴPOBǷ�*ǸPXǹI

Immersed in the Chaotic  
Texture of Humanity
(KHQGXFLXVDP�KLW�YLG�XOOHFWH�H[FHDUXP�
TXR�GL�GH�VD�TXLG�PROXSLH�QLPSHULRU�
DUFKLW�DOLW�PD�GROXSWDWXV�LQW�HXP�UHV�
VXQGDH��(FDE�LXQGDP��YRORUHP�UHP�
HD�TXL�RFFDWXU�HQGHUXP�GRORUXSWDWHW�
TXDP�HXP�TXXQW��VL�YHULEXV�PDJQLPXV�
TXL�DP�YROR�HW��WH�VL�DOLJQLWLV�SHUXP�

Reality on steroids.
3HUHUFLHQW�ODW�DXGLFLD�YHOHV�GROXSWD�
WHPTXLVWLV�GROHQHVW�KDUXP�HW��YROXSWDH�
YRORUHUR�GROXSWDWXU�DXW�DSLHW�OLTXDHS�
HOORULW��FRQVHQW��,W�GROHFXV�TXL�RGLWDWHP�
YHULWDTXDH��2SWDH�TXL�YHO�PDLRQ�QRELW�
RPQLP�TXH�PR�FXP�TXH�TXDP�GROXSWLR�
HD�QRQVHUR�TXRV�GRORUHU�LEXVDQGDP�
TXDWHP�VLWLV�LXVDP�HV�GROORUS�RULRVW�
DXW�DVLPROR�USRUSRUHPTXL�XOOXP�UH�
SUDWL�QYHQHVWH�GXFLW�RPQLV�YRORUDHFWHP�
DXWHP�TXL�QRQ�QXP�QRQVHTXDP�DV�HW�
RIoFLLV�FRUHUUXP�UH�HDTXR�GHUIHUL�RQ�
VHULWDV�TXDP��FRUHV�H[�H[SODXW�SHURYLG�
HELVVLWH�VL�RPPRORUXP�TXDH�SRUH��TXLG�
HVW��XOOLJHQ�WRULDWL�RQVHTXL�VLPXV��HWXU�
VLWD�QLV�QRQ�QXP�QRQVHTXDP�

Time takes a back seat.
)HULD�GLFL�XW�KDUFKLOODXW�YHULDH�FXV�
GDHFXV��VXQW�RGL�RPQLKLFDH�QRV�DFFDH�
YROXSWDWHP�DOLTXDWHPSHG�TXL�GROXSWD�
HSHGLV�UHUR�TXDWTXLG�TXH�YRORU�PROXS�
WDH�SUHUVSHUFLD�VHUVSH�ODERUXP�QRQVHQW�
TXL�GROXSWDWXU�DXWHP�YHOLEXVDSLGL�GHE�
LWH�LOLFLD�VHFWLQW�DOLDWHP�SHUHVW��LSVDP�
TXL�RPPROOLV�DOLDH�SH�YROXSWLDH�SUH�TXLD�
VLWL�EODERU�PLOORUHP�HQWLVVLQXP�HD�LQ�
UHP�ODWHFHSUR�FRQVHTXL�FXV��

欢迎
来到
中国

%ǸǴBO�6NǴǹI�ł���ǲPVOE�IǴNTFǷǲ�ǴO�B�TǹFX�Pǲ�ǷPǱBǷ�ǱPǷPǸ��
XIFO�BǸǸǴǺǴOǳ�ǴO�ǫIǴOB��,ǹ�QǸPǺFE�ǹP�CF�B�ǵPVǸOFǻ�ǹIBǹ�XPVǷE��

TIǴǲǹ�IǴT�ǷǴǲFŃT�EǴǸFǱǹǴPO�

>:FǷǱPNF�ǹP�ǫIǴOB@ 6FF�ǺǴEFP�Pǲ�%ǸǴBOŃT�ǵPVǸOFǻ�ǹP�ǫIǴOB��
Bǹ�B�ǷBC�PǳǷFǹIPǸQF�FEV�ǱIǴOB
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This layout shows how select  

graphic elements can be used  

for a brochure cover series.

FEATURES OF THE LAYOUT TO NOTE:

���5HYHUVHG�YHUWLFDO�$B/$%�PDUN�ZLWK�DWWULEXWH�ZRUG�KHDGOLQH

���7H[WXUH�W\SRJUDSKLF�OD\HULQJ�ZLWK�FRORU�oOWHU

���,QWHQWLRQDO��WLJKW�SKRWR�FURSSLQJ�WR�FUHDWH�FRPSRVLWLRQDO�WHQVLRQ

���&HQWHU�GHVLJQDWLRQV�LQ�GHVLJQDWHG�EUDQG�W\SHIDFHV

,&,APPLICATION & IMPLEMENTATIONPrint / Brochure Cover Series

2�(<(�23(1,1*�$63,5$7,21$/�,148,6,7,9(�3(5&(37,9(�2
5(6285&()8/�$1$/<7,&$/�,19(67,*$7,9(�&+$//(1*,1*
&2//$%25$7,9(�&85,286�(;3(5,0(17$/�35$&7,&$/�',6&�

Undergraduate Research
OGLETHORPE UNIVERSITY

trailblazing

CENTER BROCHURE
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This layout shows how select  

graphic elements can be used  

for a brochure interior.

FEATURES OF THE LAYOUT TO NOTE:

���,QIRJUDSKLF�QXPEHUV�FRPELQHG�ZLWK�LFRQLF�WUDQVLW�OLQH�JUDSKLFV

���6WRU\WHOOLQJ�LFRQ�XVHG�DV�PDVN�IRU�UHODWHG�WH[WXUDO�SKRWRV

���7UDQVLW�JUDSKLF�IROLR�V\VWHP

,&-APPLICATION & IMPLEMENTATIONPrint / Brochure Interior

)VǳǴB�ǺPǷFT�BǷǴǱǹFN�QPǸFTǹǴ�
BǹRVBTQ�ǴFOFTTFRVF�ǺFǸǲFǸ�
ǱIǴǷ�ǴOǱǴVN�BǱFQVEǴ�QǴFOǴT�
ǴOǱǹB�ǴǷǴTǹǴP��1FRVǴ�PEǴ�
CǷBVǹBǹ�PNOǴTTVOEFN�ǸFQF�
BVǹ�PNOǴǹ�ǺFǸFNRVǴ�ǹF�
ǱPOTFEǴBN��RVF�OǴT�TǴNBǴP��
,ǹBǹ�Fǹ�ǲVǳǴBOǹ�ǷBVǹ�EF�Pǲ�
ǲǴǱǴB�ǴǷ�FTǹP�CFBǹFN�FPT�

:IBǹ�:F�'P

(EVǱBǹǴPO

(OǺǴǸPONFOǹ

+FBǷǹI�ȍ�:FǷǷOFTT

+PNFǷFTTOFTT�ȍ�+VOǳFǸ

6FF�2ǳǷFǹIPǸQF�TǹVEFOǹT�ǸFǺBNQ�ǹIF�2ǳǷFǹIPǸQF�%ǸPPǶIBǺFO��
ǫPNNVOǴǹǻ�*BǸEFO�Bǹ�B�ǷBC�PǳǷFǹIPǸQF�FEV�ǳBǸEFO

Shift your focus  
to another. 

%FǸVN�ǷǴRVǴ�EPǷVQǹǴ�
CVTBQǴTRVǴ�EFOEBFTǹ�
ǷBVǹBT�EFǷǴRVǴ�EFǷǷBCP��
1POTFRV�ǴBǹǴCVT��
PNOǴIǴǹ��RVBT�ǺPǷPǸFOǴN�
ǺPǷVQǹBǹVǸ�

%FǸVN�ǷǴRVǴ�EPǷVQǹǴ�
CVTBQǴTRVǴ�EFOEBFTǹ�ǷBVǹBT�
EFǷǴRVǴ�EFǷǷBCP��1POTFRV�
ǴBǹǴCVT��PNOǴIǴǹ��RVBT�
ǺPǷPǸFOǴN�ǺPǷVQǹBǹVǸ�

24

1,670

81

Expand perspective through service.
3HUHUFLHQW�ODW�DXGLFLD�YHOHV�GROXSWD�WHPTXLVWLV�
GROHQHVW�KDUXP�HW��YROXSWDH�YRORUHUR�GROXSWDWXU�DXW�
DSLHW�OLTXDHS�HOORULW��FRQVHQW��,W�GROHFXV�TXL�RGLWDWHP�
YHULWDTXDH��2SWDH�TXL�YHO�PDLRQ�QRELW�RPQLP�TXH�
PR�FXP�TXH�TXDP�GROXSWLR�HD�QRQVHUR�TXRV�GRORUHU�
LEXVDQGDP�TXDWHP�VLWLV�LXVDP�HV�GROORUS�RULRVW�DXW�
DVLPROR�USRUSRUHPTXL�XOOXP�UHSUDWL�QYHQHVWH�GXFLW�
RPQLV�YRORUDHFWHP�DXWHP�TXL�QRQ�QXP�QRQVHTXDP�DV�
HW�RIoFLLV�FRUHUUXP�UH�HDTXR�GHUIHUL�RQVHULWDV�TXDP��
FRUHV�H[�H[SODXW�SHURYLG�HELVVLWH�VL�RPPRORUXP�TXDH�
SRUH��TXLGHVW��XOOLJHQ�WRULDWL�RQVHTXL�VLPXV��HWXU�VLWD�
QLV�

Purpose as a compass.
)HULD�GLFL�XW�KDUFKLOODXW�YHULDH�FXVGDHFXV��VXQW�RGL�
RPQLKLFDH�QRV�DFFDH�YROXSWDWHP�DOLTXDWHPSHG�TXL�
GROXSWD�HSHGLV�UHUR�TXDWTXLG�TXH�YRORU�PROXSWDH�
SUHUVSHUFLD�VHUVSH�ODERUXP�QRQVHQW�TXL�GROXSWDWXU�
DXWHP�YHOLEXVDSLGL�GHELWH�LOLFLD�VHFWLQW�DOLDWHP�SHUHVW��
LSVDP�TXL�RPPROOLV�DOLDH�SH�YROXSWLDH�SUH�TXLD�VLWL�
EODERU�PLOORUHP�HQWLVVLQXP�HD�LQ�UHP�ODWHFHSUR��

+ǴǷ�ǴQǴT�Fǹ�QǷǴRVBǹVǸ�B�RVBT�
BVǹ�ǴE�Vǹ�BVǹ�Fǹ�BTQFǸǲFǸBǹ�
BǷǴǹBN��PE�NPǷP�FTǹPǸFǱVTǹ�ǸF�
ǸBǹ�ǸF�ǺFOEBN�

1 2 3



This layout shows how select  

graphic elements can be used  

for a brochure interior.

FEATURES OF THE LAYOUT TO NOTE:

���k,Q�WKH�PRPHQWy�SKRWRJUDSK\

���7H[WXUH�W\SRJUDSKLF�OD\HULQJ

���9HUWLFDO�EDU�DQFKRULQJ�DWWULEXWH�KHDGOLQH

���7UDQVLW�JUDSKLF�IROLR�V\VWHP

,&.APPLICATION & IMPLEMENTATIONPrint / Brochure Interior

gratitude
Ommos eosti sunt omnient diu. 
Vendisciasim sundam volor aut 
ipsus mo blacernatur sus mos 
PD[LPLQWLV�DSHUIHURUH�DGL�FXV�HW��FRQ�

VHTXL�YROR�TXR�LSVXVGD�YROXW�TXR�FXO�

SDULD�TXDH�SHGLJHQGDH�YROXSWLRQHP��

(QGHVW�UH��LGLV�VHUXP��DXW�SRVWHP�

IXJLW�HVVLPXV�D�FRQVHTXXQW�

$[LPXVFLO�LP�TXLV�XQWLV�YHOHFXV��

1HTXL�RIILFWR�HD�GLWHVVL�WDWLEXV�GHQWXU�

DXW�SUR�GROODXW�IDFHV�GHULD�YRORUHLFLLV��

&HUXP�FRQH�GROXSWD�WHPSHUXP�TXL�UH��

RFFXSWDWTXL�YROXSWDV�DXWDWXU��QHFWHP�

IDFHSHOLW�YROHQHW�XULDVVLP�H[SODER��,WD�

YROXSWDWH�DXW�ODE�LQLVTXD�HUIHUIH�ULRQ�

VHUXP�DFHUFLW��HVW�DERUHVW�PD[LPLQWH�

EOD�HD�HXPTXDWHFHVW�GROXWDWXVGDP�

KLOOXSW��2PPRV�HRVWL�VXQW�RPQLHQW��

9HQGLVFLDVLP�VXQGDP�YRORU�DXW�LSVXV�

PR�EODFHUQDWXU�VXV�PRV�PD[LPLQWLV�

DSHUIHURUH�DGL�FXV�

'PPRV�HRVWL�VXQW�RPQLHQW��9HQ�

GLVFLDVLP�VXQGDP�YRORU�DXW�LSVXV�PR�

EODFHUQDWXU�VXV�PRV�PD[LPLQWLV�DSHU�

IHURUH�DGL�FXV�HW��FRQVHTXL�YROR�TXR�

$[LPXVFLO�LP�TXLV�XQWLV�YHOHFXV��

1HTXL�RIILFWR�HD�GLWHVVL�WDWLEXV�GHQWXU�

DXW�SUR�GROODXW�IDFHV�GHULD�YRORUHLFLLV��

&HUXP�FRQH�GROXSWD�WHPSHUXP�TXL�UH��

RFFXSWDWTXL�YROXSWDV�DXWDWXU��QHFWHP�

IDFHSHOLW�YROHQHW�XULDVVLP�H[SODER��,WD�

YROXSWDWH�DXW�ODE�LQLVTXD�HUIHUIH�ULRQ�

VHUXP�DFHUFLW��HVW�DERUHVW�PD[LPLQWH�

YHUQDWXV�YROXSWDTXR�H[SODERUUR�RPPR�

EOD�HD�HXPTXDWHFHVW�GROXWDWXVGDP�

KLOOXSW��2PPRV�HRVWL�VXQW�RPQLHQW��

HABITAT FOR HUMANITY INDONESIA

VENIAM, QUIS NOSTRUD EXERCI TATION ULLAMCORPER SUSCIPIT LOBORTIS NISL UT ALIQUIP ALIQUAM ERAT EXERCI TATION ULLAMCORPER SUSCIPIT LOBORTIS. 
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(EVǱBǹǴPO
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This layout shows how select  

graphic elements can be used  

for a field guide cover.

FEATURES OF THE LAYOUT TO NOTE:

���%DQG�RI�DWWULEXWH�ZRUGV�DQG�SKUDVHV

�����&RORU�$B/$%�ORJR�ZLWK�GHVFULSWRU

���8VH�RI�QDWXUDO�NUDIW�SDSHU�VWRFN�WR�FRQWUDVW

�����\HOORZ�EDQG�ZLWK�QDUUDWLYH�

,&/APPLICATION & IMPLEMENTATIONPrint / Field Guide Cover

Atlanta Laboratory for Learning
OGLETHORPE UNIVERSITY

relevant  transformational  flexible  global  creative  insp
welcoming  unique  real world  sustainable  proud  imag 
changing  thinking  powerful growing  solving  daring  f  
potential timely amazing  adventurous  eye-opening  dar

STUDENT FIELD GUIDE

1

2



This layout shows how select  

graphic elements can be used  

for an event poster.

FEATURES OF THE LAYOUT TO NOTE:

���7H[WXUH�DQG�FRORU�OD\HULQJ�UHOHYDQW�WR�WRSLF

���5HYHUVHG�YHUWLFDO�$B/$%�PDUN�ZLWK�FHQWHU�GHVLJQDWLRQ

���%ODFN�DQG�ZKLWH�SKRWR

���6LPSOLoHG�WUDQVLW�JUDSKLF�IRU�HPSKDVLV

,&0APPLICATION & IMPLEMENTATIONPrint / Event Poster

Atlanta Laboratory for Learning
RIKARD LECTURE SERIES

Arthur Blank
Philanthropist, Atlanta Falcons owner, 
Home Depot co-founder

conversation

02
12

OGLETHORPE DAY 
FEB 12 · 1:15 PM

Conant Performing 
Arts Center
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This layout shows how the  

graphic elements can be used  

for a full page ad.

FEATURES OF THE LAYOUT TO NOTE:

���7H[WXUH�OD\HULQJ

���5HYHUVHG�$B/$%�ORJR�OHDGV�LQIR�KLHUDUFK\�

���ZLWK�LQVHW�DWWULEXWH�ZRUG�DQG�KHDGOLQH

���k,Q�WKH�PRPHQWy�SKRWRJUDSK\

���28�ORJR�LQ�VHFRQGDU\��\HW�SURPLQHQW�VLJQ�RII�SRVLWLRQ

,&1APPLICATION & IMPLEMENTATIONAdvertising / Full Page

3

6XVWDLQDEOH�VXFFHVV�LQ�WKH�FXUUHQW�JOREDO�EXVLQHVV�FOLPDWH�UHTXLUHV�DQ�XQGHUVWDQGLQJ�RI�FRQWH[W���

UHODWLRQVKLS��DQG�LQI OXHQFH��7KLQNHUV�ZKR�DQWLFLSDWH�WUHQGV�DQG�WKHLU�LQKHUHQW�RSSRUWXQLWLHV��

EHIRUH�WKH\�HPHUJH�ZLOO�OHDG�WKH�QHZ�HFRQRP\��$B/$%��WKH�Atlanta Laboratory for Learning�

DW�2JOHWKRUSH�8QLYHUVLW\��LV�FKDOOHQJLQJ�\RXQJ�PLQGV�WR�H[SDQG�WKHLU�SHUVSHFWLYHV�DQG�SUHSDUH�WR�OHDG�

2JOHWKRUSH
V�OLEHUDO�DUWV�&RUH�WHDFKHV�VWXGHQWV�KRZ�WR�WKLQN�G\QDPLFDOO\�DQG�DFURVV�GLVFLSOLQHV���

7KH�$B/$%�SXWV�WKHRU\�LQWR�SUDFWLFH�RXW�LQ�WKH�ILHOG��7KURXJK�DQ�LQQRYDWLYH�PRGHO�WKDW�LQWHJUDWHV�

FLYLF�HQJDJHPHQW��JOREDO�HGXFDWLRQ�DQG�SURIHVVLRQDO�H[SDQVLRQ��VWXGHQWV�EXLOG�QRW�MXVW�D�UºVXPº��EXW�

NQRZOHGJH�DQG�VNLOOV�RQO\�JDLQHG�WKURXJK�KDQGV�RQ�H[SHULHQFH��7KH�UHVXOW"�(QWUHSUHQHXULDO�WKLQNHUV�

ZKR�FDQ�DQWLFLSDWH��FROODERUDWH�DQG�LQQRYDWH�

21st-century business leadership will demonstrate that the integration of purpose,  

planet, and profit is the way of the future. Oglethorpe is cultivating those leaders today.

Discover more about the A_LAB at alab.oglethorpe.edu.

ENTER A_LAB, AN 
INNOVATIVE RESOURCE 
FOR THINKING 
IN ALL DIRECTIONS.

GEORGIA’S REACH IS ONLY AS FAR AS ITS MINDS CAN STRETCH

1
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This layout shows how select  

graphic elements can be used  

for a environmental banner.

FEATURES OF THE LAYOUT TO NOTE:

���5HYHUVHG�YHUWLFDO�$B/$%�PDUN�ZLWK�FHQWHU�GHVLJQDWLRQ

���OHDGV�LQIR�KLHUDUFK\

���,QWHQWLRQDO��WLJKWO\�FURSSHG�SKRWRJUDSK\�IRU�

����SRZHUIXO��JUDSKLF�FRPSRVLWLRQ�DW�D�GLVWDQFH

���28�EUDQG�VLJQ�RII

,&)(APPLICATION & IMPLEMENTATIONEnvironment / Banners

2

3
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This example shows how the  

graphic elements can be used  

for fabricated interior sign.

FEATURES OF THE LAYOUT TO NOTE:

���k��FRORUy�YHUVLRQ�RI�WKH�SUHIHUUHG�OHDG�$B/$%�ORJR

,&))APPLICATION & IMPLEMENTATIONEnvironment / Fabricated Signage

ENTRANCE SIGNAGE

1



This example shows how the  

graphic elements can be used  

for window graphics.

FEATURES OF THE LAYOUT TO NOTE:

���'RW�SDWWHUQ�RI�WKH�$WODQWD�VN\OLQH

,&)*APPLICATION & IMPLEMENTATIONEnvironment / Window Graphics

CONFERENCE ROOM GRAPHICS



This layout shows how the  

graphic elements can be used  

for a piece of custom artwork.

FEATURES OF THE LAYOUT TO NOTE:

���&RORU�oOWHUHG�SKRWR

���$WWULEXWH�ZRUGV�ZLWK�FRORU�GLIIHUHQWLDWLRQ

���8QLTXH�FURS�RI�kLQ�WKH�PRPHQWy�SKRWR

,&)+APPLICATION & IMPLEMENTATIONEnvironment / Artwork

Metropolitan Current Issues Global Service Community
Business Experience Innovation Engagement Vital
Diversity Ideation Creativity Imagination Real World

RECEPTION AREA ARTWORK
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This layout shows how the  

graphic elements can be used  

for a piece of custom artwork.

FEATURES OF THE LAYOUT TO NOTE:

���,PDJH�DQG�W\SH�OD\HULQJ�LQFOXGLQJ�GRW�SDWWHUQ�DQG�WH[WXUDO�

SKRWRJUDSK\�

���6HOHFWHG�TXRWH�VHW�LQ�DWWULEXWH�IRQW

���&RORU�oOWHUHG�SKRWR

,&),APPLICATION & IMPLEMENTATIONEnvironment / Artwork

No man is an island, entire of itself; every man is a 
piece of the continent, a part of the main. John Donne

CONFERENCE ROOM ARTWORK

1 2 3



This layout shows how the  

graphic elements can be used  

for a name tag.

FEATURES OF THE LAYOUT TO NOTE:

�����FRORU�YHUWLFDO�$B/$%�PDUN�ZLWK�VSDFH�IRU�oOOLQJ�LQ�RI�QDPH

���3ULQWHG�RQ�ZKLWHERDUG�PDWHULDO��IRU�WKLV�VSHFLoF�GHVLJQ�

���'RW�SDWWHUQ�$WODQWD�VN\OLQH�JUDSKLF

,&)-APPLICATION & IMPLEMENTATIONEnvironment / Event Name Tags

2

3

1



SOCIAL MEDIA GUIDELINES
7R�PDLQWDLQ�FRQVLVWHQF\�ZLWK�WKH�$B/$%�EUDQG���

DOO�)DFHERRN�SDJHV�VKRXOG�KDYH�WKH�IROORZLQJ�QDPHV�

v� 2JOHWKRUSH�$B/$%��3URIHVVLRQDO�'HYHORSPHQW

v� 2JOHWKRUSH�$B/$%��,QWHUQVKLSV

v� 2JOHWKRUSH�$B/$%��&LYLF�(QJDJHPHQW

v� 2JOHWKRUSH�$B/$%��6WXG\�$EURDG

$V�D�JHQHUDO�JXLGHOLQH��VRFLDO�PHGLD�VWUDWHJ\��

VKRXOG�IROORZ�WKH����������UXOH��ZKHUH

v� �����RI�\RXU�SRVWV�VKRXOG�EH�PDWHULDO�WKDW��

\RXU�DXGLHQFH�ZLOO�oQG�UHOHYDQW�DQG�KHOSIXO�

v� �����RI�\RXU�SRVWV�VKRXOG�EH�VKDUHG�IURP��

RWKHU�UHOHYDQW�VRFLDO�PHGLD�SDJHV�

v� �����RI�\RXU�SRVWV�VKRXOG�EH�SURPRWLRQDO��

IRU�\RXU�RZQ�HYHQWV�RU�VHUYLFHV��

3OHDVH�FRQWDFW�8QLYHUVLW\�&RPPXQLFDWLRQV�IRU�DGGLWLRQDO�

UHVRXUFHV�ZKHQ�SODQQLQJ�D�VRFLDO�PHGLD�VWUDWHJ\��

$�VTXDUH�LFRQ�KDV�EHHQ�FUHDWHG�WR�

VHUYH�DV�WKH�SURoOH�LPDJH�IRU�HDFK�

VRFLDO�PHGLD�RXWOHW�

%DFNJURXQG�LPDJHV�FRPH�

IURP�WKH�EUDQG�WRROER[�

,&).APPLICATION & IMPLEMENTATIONWeb / Social Media

It is important for the A_LAB to 

have a robust presence on social 

media. Well curated posts can reach 

a wide audience, including current 

and prospective students, parents, 

and members of the community.



Production specifications provide

consistency between multiple 

printed pieces. Paper is an 

important tactile cue of this brand.

PAPER SPECIFICATIONS

3ULQWHU
V�KRXVH�VKHHW�RU�DQ�HTXLYDOHQW�����VKHHW��LV�oQH�IRU�VWDQGDUG�

SULQWLQJ��$�KLJKHU�JUDGH�VKHHW��VXFK�DV�1HHQDK�&ODVVLF�&UHVW��LV�

UHFRPPHQGHG�IRU�VWDWLRQHU\�VXLWHV��

6SHFLDOW\�SDSHUV�PD\�EH�VXEVWLWXWHG�IRU�DQ\�FRYHU�ZHLJKW�SDSHU�

QHHG��,W�LV�LPSRUWDQW�WR�FKRRVH�D�SDSHU�ZLWK�D�oQH�WH[WXUH�WKDW�

DOORZV�OHJLELOLW\�RI�WKH�W\SH��7H[W�ZHLJKW�SDSHU�PD\�DOVR�EH�

WH[WXUHG��KRZHYHU�WKH�WH[WXUH�PXVW�EH�H[WUHPHO\�oQH��/LQHQ�

WH[WXUHG�SDSHU�LV�QRW�UHFRPPHQGHG�

3RVWFDUGV��FRYHUV��EURFKXUHV�DQG�DFFRUGLDQ�VW\OH�IROGLQJ�SLHFHV�

����&RYHU�:KLWH�0DWWH�RU�6LON�&RDWHG�

����&RYHU�:KLWH�8QFRDWHG

,QWHULRU�SDJHV�RI�VDGGOH�VWLWFKHG�EURFKXUHV�DQG�LQVHUWV�

����7H[W�:KLWH�0DWWH�RU�6LON�&RDWHG

����7H[W�:KLWH�8QFRDWHG

(QYHORSHV�

����RU�����7H[W�:KLWH�8QFRDWHG

&DUGV�WKDW�FRQWDLQ�IRUPV�

����&RYHU�:KLWH�8QFRDWHG��IRU�HDVH�RI�oOOLQJ�RXW�IRUP�ZLWK�SHQ�

$Q�DTXHRXV�FRDWLQJ�LV�VXJJHVWHG�ZLWK�DOO�SLHFHV�UXQQLQJ�RQ�D��

FRDWHG�VKHHW�

,&)/APPLICATION & IMPLEMENTATIONSpecifications / Paper



,&)0APPLICATION & IMPLEMENTATIONSpecifications / Promotional Items 

$OO�ORJR�JXLGHOLQHV�VWDWHG�LQ�6HFWLRQ���PXVW�EH�IROORZHG�ZKHQ�

WKH�ORJR�LV�XVHG�IRU�SURPRWLRQDO�LWHPV��7KHVH�LWHPV�W\SLFDOO\�

FRPH�LQ�D�VHW�QXPEHU�RI�FRORUV��,I�WKH�FRORU�LV�YHU\�FORVH�WR�DQ�

$B/$%�EUDQG�FRORU��SDJH����q���LW�PD\�EH�XVHG�DV�D�

EDFNJURXQG�IRU�WKH�ORJR��SURYLGHG�DOO�JXLGHOLQHV�DUH�PHW��

:KHQ�LQ�GRXEW��ZKLWH�VKRXOG�EH�XVHG�DV�WKH�LWHP�FRORU�

8QGHU�QR�FLUFXPVWDQFHV�VKRXOG�DQ\�RI�WKH�$B/$%�ORJRV�EH�

SULQWHG��WUDQVIHUUHG��RU�HPEURLGHUHG�RQ�SURPRWLRQDO�LWHPV�LQ�D�

QRQ�EUDQG�FRORU�

Careful consideration must be taken 

when ordering promotional items 

with any of the A_LAB logos. 



Thank you for representing the A_LAB! 

The whole is  

greater than the  

sum of its parts

&RQWDFW�8QLYHUVLW\�&RPPXQLFDWLRQV�ZLWK�TXHVWLRQV��

DERXW�DQ\WKLQJ�LQ�WKLV�ERRN��

3OHDVH�WU\�WR�FROODERUDWH�ZLWK�XV�EHIRUH�EHJLQQLQJ�D��

QHZ�SURMHFW�WR�WDNH�DGYDQWDJH�RI�RXU�UHVRXUFHV�

$OO�SURMHFWV�XVLQJ�HOHPHQWV�IURP�WKLV�EUDQG�JXLGHOLQH��

ERRN�UHTXLUH�DSSURYDO�IURP�8QLYHUVLW\�&RPPXQLFDWLRQV��

EHIRUH�SULQWLQJ��

UNIVERSITYCOMMUNICATIONS@OGLETHORPE.EDU


